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Section I: Introduction to Lean and Value Stream Mapping  

A. What is Lean? 

Lean is a systematic approach to identifying and eliminating waste (non-value-added activities) through continuous 

improvement.  The approach calls for product flow at the pull of the customer and in pursuit of perfection.  The term 

‘Lean’ is used because Lean manufacturing uses less: 

 human effort in the factory 

 manufacturing space 

 capital investment 

 materials 

 time between the customer order and the product shipment 

 

B. Why Do Companies Transition to Lean? 

Most companies view Lean as a means to an end.  By embracing and implementing Lean, they are able to achieve and 

maintain competitive strategic advantage by providing: 

1. Quality Product - Standard expectation of Global Customer 

2. Cost Competitive Product/Service and Process 

 High Productivity 

 Minimum WIP / Inventory 

3. Flexibility - Process are responsive to rapidly changing conditions 

4. Speed - First To Market 

 Lead-time Competitive  

 New Products/Timely Introduction 

5. Simple Processes 

 Dependable 

 Capable Processes 

 Repeatable 

 

C. What is Value Stream Mapping? 

Lean follows a structured process that starts with Value Stream Mapping. The Value Stream is a collection of processes 

that create value for the customer.  A Value Stream consists of the activities, transports, queues and inventories, both 

value added (VA) and non-value added (NVA), required to bring the product or service from raw material to customer. 

The Value Stream includes: 

 People 

 Tools and technologies 

 Physical facilities 

 Communication channels 

 Policies and procedures 
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Section I: Introduction to Lean and Value Stream Mapping  

A Value Stream Map (VSM) helps companies document and visualize the flow of information and materials through the 

various process/manufacturing steps required to transform raw materials into finished goods.  By analyzing a Value 

Stream, companies can identify improvement opportunities that, when implemented, will enable the company to do 

more with less while meeting or exceeding customer expectations. 

D. The role of LeanView in Value Stream Mapping & Analysis 

The traditional approach to Value Stream Mapping & Analysis usually involves Lean or Six Sigma practitioners walking a 

product or service Value Stream from end-to-end.  This process enables the practitioner to "see" the flow of information 

and materials at point-of-use. The process of "seeing the flow" is fundamental to Lean and must be performed. 

The next step in the process is to create a picture of the Value Stream which is called the Value Stream Map (VSM). Most 

practitioners draw the VSM using paper and pencil and then create an electronic version using Microsoft Visio, 

PowerPoint or Excel.  The practitioner must then capture and analyze all of the operational and financial data associated 

with the Value Stream.  Practitioners routinely use Excel to perform these steps. 

As with any such manual process, information technology solutions can go a long way towards enabling and sustaining 

the process. An increasing number of Lean and Six Sigma practitioners are looking to LeanView to help enable and 

sustain the process.  LeanView's capabilities go beyond basic drawing and analysis to provide a robust tool for Value 

Stream Mapping, Lean Process Design, Lean Analysis, and Lean Implementation. 

By using LeanView, companies stand to realize the following benefits: 

 Connectivity 

o Collaborate more effectively as a Lean team 

o Access Lean project information at all levels in the organization, at the desired level of detail 

o Give practitioners training and information when they need it, relevant to the context 

 Productivity 

o Maximize Lean results with project and resource planning, forecasting, and tracking 

o Improve Lean and business processes continuously 

o Automate routine report creation 

o Increase training efficiencies 

 Dependability 

o Use reliable, proven Microsoft technology and services from Microsoft and certified partners 

o Plan firm goals, achieve desired results 

o Achieve solid top-level executive support for Lean and its critical role in your organization 
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Section I: Introduction to Lean and Value Stream Mapping  

LeanView was developed with one formula in mind: Lean = fewer required resources. That is, Lean allows organizations 

to use less space, less capital, less material and less time to produce a given set of products or perform a given set of 

functions.   

To that end, Bluespring provides a comprehensive Value Stream Mapping, Analysis, and Reporting tool that leverages 

and extends the most commonly used Microsoft Office Products, thereby allowing Lean practitioners to rapidly adopt 

and utilize the tools, power, and extensibility in a highly flexible and collaborative environment. 

LeanView Improves and Integrates Lean and Six Sigma processes and programs. 

 Streamline drawing, distribution, and updating of value stream map (VSM) diagrams. 

 Automatically calculate key operational metrics for each VSM state. 

 Transform raw financial and process data into business intelligence as a Microsoft Excel document depicting key 

performance indicators for each VSM state. 

 Seamlessly transform process improvement opportunities into actionable project plans. 

 Assist the finance department with Sarbanes-Oxley compliance by closing the gap between reported Lean 

savings and actual bottom-line performance. 

Communicate information clearly and collaborate more effectively. 

 Create comprehensive management reports for each value stream. 

 Add hyperlinks between parts of a LeanView diagram, to other LeanView diagrams, or to supporting files or Web 

pages for enterprise-level views. 

 Share LeanView diagrams from within Microsoft Visio® interface using Document Workspaces that reside on 

Windows SharePoint Services sites. 

 Populate management dashboards with Solution XML and Visio XML output from LeanView. 

 Identify and prioritize opportunities to improve your value stream. 

 Project operational improvements to your value stream. 

LeanView and the Supply Chain 

LeanView allows practitioners and managers to assess overall performance of their supply chains by linking to Value 

Streams at the supplier level and allowing “Roll-Up” analysis of process performance data. 

Organizations can request that suppliers utilize LeanView to create Current state Value Stream Maps, and can use 

Microsoft collaboration technologies such as Microsoft Windows SharePoint Services and Microsoft Office Project Server 

to share and collaborate with suppliers to reduce costs throughout the entire supply chain. 

Whether through collaborative use or standalone use by suppliers, LeanView allows opportunities for improvement to 

be identified and quantitatively analyzed, thus reducing the costs of materials and parts supplied to your production or 

service lines.  Please contact Bluespring Software if you are interested in incorporating LeanView into your Supply Chain.  
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Section I: Introduction to Lean and Value Stream Mapping  

LeanView provides a toolset that allows the improvement team to clearly visualize, fully define, and confidently validate 

any product or service value stream.   
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Section II: The LeanView Environment  

LeanView provides a drawing template and shape stencils to make value stream map construction easy. 

A LeanView drawing can be quickly created through the Visio File menu.  To open a LeanView diagram, launch Microsoft 

Visio (2007 or 2010) and, through the Visio File menu, choose New  LeanView  LeanView Diagram.    

  

If utilizing LeanView 6.0 in Visio 2010, users may also create a new LeanView drawing by launching Microsoft Visio 2010, 

accessing the LeanView ribbon, and clicking the ‘New LeanView Value Stream’ button. 

 

In LeanView version 4, a new LeanView drawing may be created through the Windows Start menu. 

 

 

 

 

  

Note: The LeanView menu will 

only appear when a LeanView 

Diagram is open. 

Note that, in LeanView versions 4 and 5, the 

LeanView menu is only visible when a 

LeanView drawing is active. 

In LeanView version 6, the LeanView ribbon 

is always visible, but only active when a 

LeanView drawing is open. 
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Section II: The LeanView Environment  

Once a diagram is created with the LeanView template, a drawing canvas and shape stencils are presented.  
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In LeanView versions 4 and 5, 

the LeanView Menu is on the 

Visio 2010 Add-Ins ribbon. 

In LeanView version 6, LeanView has its own ribbon 

on the Visio 2010 toolbar. 

With Visio 2007, with LeanView versions 4, 5 and 6, the LeanView 

menu will appear to the right of the Visio menus. 
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LeanView 6.0.x Ribbon (Visio 2010) 

 The LeanView ribbon is divided into six sections:  Data, Analysis, View, Import, Export, and Information. 

 

Data 

The Data menu provides access to an input sheet where LeanView shape properties can be reviewed and revised.  

Properties for process shapes linked to sub-value paths can be automatically updated; any Visio shape can be converted 

into a LeanView shape using the Data menu. 

  

Analysis 

Value Stream performance information can be reported to Microsoft Excel in the Map Analysis Report or Compare 

Report.  Performance metrics and information about improvement opportunities may also be reported to Microsoft 

PowerPoint and Word. 

 

View 

The View menu provides the ability to ‘show’ or ‘hide’ flow paths highlighters and shape titles, statistics, and operators. 

   
Flow Path Highlighter

2

YLD 80.00%

CO 0.00 Hrs

AT 0.00 Hrs

MT 2.00 Mins

FT 10.00 Mins

Review OrderShape Title 

Shape Operator 

Shape Statistics 
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Section II: The LeanView Environment  

LeanView 6.0.x Ribbon (Visio 2010) 

Import 

Shape properties data can be imported from an Excel worksheet.  Value stream maps can be automatically drawn and 

shape properties imported using an Excel worksheet created with the LeanView Value Path Walker template. 

 

Export 

Shape properties data can be exported to Microsoft Excel.  Additionally, kaizen burst shape properties to describe 

improvement actions, tasks and resources can be exported to Microsoft Excel or Microsoft Project.  LeanView diagrams 

created with older versions of LeanView (< 5.0.0) can be updated using the new LeanView template with the ‘Duplicate 

Map’ option. 

 

Information 

Access to the LeanView Getting Started Tutorial, example value streams, and LeanView Online Resources can be 

obtained using the options in the information section of the LeanView ribbon.  Additionally, information about the 

LeanView version and license can be reviewed by selecting the ‘About’ button.  

  

   

  

Bluespring Online provides 

Tips & Tricks topics and a 

Video Library. 
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Section II: The LeanView Environment  

LeanView 4.0.x, 5.0.x Menu (Visio 2007 & 2010) 

In Visio 2007, the LeanView menu appears to the right of the Visio menus.  In LeanView 

versions 4 and 5, the LeanView menu appears on the Add-Ins ribbon of Visio 2010.   

Note the LeanView menu will only appear when a LeanView diagram is active. 

 …  

Reports 

Value Stream performance information can be reported to Microsoft Excel in the Map Analysis Report.  Performance 

metrics and information about improvement opportunities may also be reported to Microsoft PowerPoint and Word. 

 

View 

The View menu provides the ability to ‘show’ or ‘hide’ flow paths highlighters and shape titles, statistics, and operators. 

 

 

Data 

The Data menu provides access to an input sheet where LeanView shape properties can be reviewed and revised.  

Properties for process shapes linked to sub-value paths can be automatically updated and any Visio shape can be 

converted into a LeanView shape using the Data menu.  

  

 

  

2

YLD 80.00%

CO 0.00 Hrs

AT 0.00 Hrs

MT 2.00 Mins

FT 10.00 Mins

Review Order

Flow Path Highlighter

Input Sheet 

Shape Title 

Shape Operator 

Shape Statistics 

Create sub-paths and ‘roll’ performance metrics to update ‘parent’ process properties automatically. 
 
Leverage custom shapes... Any Visio shape can be converted into a LeanView shape. 
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Section II: The LeanView Environment   

LeanView 4.0.x, 5.0.x Menu (Visio 2007 & 2010) 

Import 

Shape properties data can be imported from an Excel worksheet; a shape data worksheet can be created with the 

LeanView export shape data option.  Value stream maps can be automatically drawn and shape properties imported 

using an Excel worksheet created with the LeanView Value Path Walker template.  

  

 

 

 

 

Export 

Shape properties data can be exported to Microsoft Excel.  Kaizen burst shape properties to describe improvement 

actions, tasks and resources can be exported to Microsoft Excel or Microsoft Project.  LeanView diagrams created with 

older versions of LeanView (< 5.0.0) can be updated using the new LeanView template with the ‘Duplicate Map’ option. 

 

 

Help 

This User’s Guide, a Quick Start Tutorial and example value stream maps are available in the LeanView Help.  

Additionally, LeanView version information and access to the LeanView support team are also available in the Help. 

 
  

Start → All Programs 

Shape Data Worksheet 

Value Path Walker Worksheet 
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Section II: The LeanView Environment   

Business Case Analysis Work Area 

The Business Case Analysis Work Area allows you to define the Business Case for creating the Value Stream Map, the 
Value Statement or what you expect to achieve from this exercise, the Key Requirements or what operational 
requirements are to be met upon completion and implementation of this process, the Measurements or how you will be 
measuring success and the Ideal State which you are seeking to obtain by this process. 

 

 

 

 

 

LeanView Value Stream Map Properties  

The LeanView value stream map properties shape is used to store information about the product or service being 

analyzed.  The Map Properties shape stores information about the quantity and cost of finished goods to be produced 

and raw materials to be consumed in the demand period.  Additionally, the work schedule and default properties can be 

defined in the map properties dialog.   
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 No additional staffing

Measurements

 Flow Time
 VA/NVA ratio
 Customer 

Satisfaction Rating

Ideal State

 On-Demand
 Defect Free
 1-By-1
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Section II: The LeanView Environment   

LeanView Shape Stencils 

The standard LeanView shapes are preconfigured to store various shape attributes and Lean data items.  The General 

stencil contains Value Path and various data and loop shapes.  The Information stencil contains shapes to represent how 

data or information is gathered and sent, and the Materials stencil contains shapes to track the movement of materials 

throughout the process. 

 

 

 

 

 

Note, any Visio shape can be used for map construction, but only shapes pulled from the LeanView General, Information 

and Material stencils are preconfigured to store lean process data.  If other Visio shapes are used to build a value stream 

map, these shapes will need to be converted to LeanView shapes.   (LeanView  Data  Convert Shapes) 
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Section III: Getting Started 
 
A:  To begin, create a new Visio diagram using the LeanView template.  Locate the red clipboard 

shape titled “Map Properties” in the lower left hand corner.  The Map Properties shape is used 
to store information about the products or services being delivered and the raw materials 
consumed to deliver the good or service. 

 
 
B: Right-click on the Map Properties shape and select “VSM Properties”. The Map Properties dialog will be launched. 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
C: Enter the Customer Name ‘We R Bikes’ and enter a value for the Map Author. 
 
D: Switch to the Customer Demand Tab.  Enter Product Family “Performance Series Bicycles”. 
 
E: Enter a Customer Demand Period of 40 hrs. 
 
F: Enter an Item “500 Series” with Quantity 300 and Price $224.00. 
 

 
 

G: Click “Save” 
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Section III: Getting Started 
 
Notice once changes to the Map Properties are saved, the information block in the top right of the LeanView diagram 
reflects the Customer, Product and Demand information. 
 
 
 
 
 

 
 
 
 
 
 

 
 
H: Close the Map Properties Dialog. 
 
I: Save your Value Stream Map as “500 Series Current State VSM”. 
 

 
Section IV: Drawing a Value Stream Map with LeanView  

 
A:  Now that the customer demand is defined, the next step is to draw the value stream map. 
 
B:  Go to the Material shapes stencil and drag the standard shapes onto the drawing area to create the VSM shown 

below. (Supplier > Finished Goods > Transport > Process > Push > Inventory > Process > Push > Inventory > Process > 
Push > Warehouse > Finished Goods > Customer)  
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Section IV: Drawing a Value Stream Map with LeanView  
 

C:  Rename the processes “Step 1”, “Step 2”, and “Step 3” from left to right.  You can accomplish this by double clicking 
on the process, so that it highlights the name (as shown above), then you type in the new name.  Once you’re done, 
click on another spot on the VSM, and the name will be saved. 

 

 
 
D: Right-click menu’s:   
 

Select one of the processes (by clicking on it), then right-click; notice that 
several options are presented.  All LeanView shapes have right-click menu 
options and the LeanView context menu options will appear at the top of the 
context menu. 

 
E:  Open and review the Process Properties dialog. 
 

General Tab 
The General tab contains the Process Data, Delays, and Calculated Statistics. 
 
Pieces Tab 
The Pieces tab is used to store information about the number of pieces per unit. 
[Example: Wagon Assembly = 1 shell, 4 wheels, etc…] 
 
Waste Tab 
The waste tab holds information about the costs associated with the 7 major wastes. 

 

Stations Tab 
This tab provides a mechanism to define a takt time for a process station. 
 
Notes Tab 
All LeanView shapes have a notes tab to store supplemental information and comments. 

 

   
1

Step 3
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Section IV: Drawing a Value Stream Map with LeanView  
 

F:  Enter Process Data for Step 3. 
 

•  Enter a Flow Time of 435 and change units to minutes [Note: that you have many options for time units] 
•  Enter a Manual Time of 7 Hrs 
•  Enter an AT (Automated Time) of 6.5 minutes 
•  Enter a yield of 97 % 
 Enter a %VA of 100% 
 

G.  Without saving the process properties, click on another process box.  Notice that LeanView prompts you to save 
your data!!! 

 
H:  Click “Yes” to save changes. 
 
I:  Enter the following data for Steps 1 and 2. 
 

 Step 1 Step 2 

Flow Time-Input (FT) 18 Mins 1 Days 

Manual Time (MT) 9 Mins 7 Hrs 

% Yield (YLD) 95%  89%  

% VA Processing Time 0%  80%  

 
 
J:  Switch back and forth between Step 2 and Step 3 by clicking on each process shape.   
 

Notice that LeanView automatically displays the data for the shape that you click on while the properties box is 
open. 

 
K:  Don’t forget to save your work!!!  
 
 
Now the most basic features of the Value Stream Map have been defined, the shapes must be recorded into a LeanView 
value path shape before analysis can be performed. 
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Section V: Recording a Value Stream with LeanView 
 
We need to be able to tell LeanView what data needs to be included in our analysis, so that the system can generate 
meaningful output when the time comes to analyze our Value Stream. In order to do this, we need to record our Value 
Stream Path. 
 
A:  Locate the “Value Stream Path” shape on the lower right corner of your VSM drawing.  If a value 

stream path is not found on the page, a new value path shape may always be pulled from the 
LeanView General shape stencil. 

 
B:  Right-click on this shape and choose “Define Value Stream Path”. You will be presented with a Value Stream Path 

Dialog with four tabs. 
 
C:  Click on the Red record button on the “Items” tab. 
 

 
 
D:  Click on each of the shapes, in order, from left to right (omit finished goods/push arrows).  You will notice that each 

of the 3 steps appear, in order that you clicked them, in the Value Stream Path dialog. 
 

 
 
E:  Click on the “Save” Button to Save the recorded Value Stream Path.   
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Section V: Recording a Value Stream with LeanView 
 
Notice that along the Value Stream Path you have recorded, there are numbered Bubbles that indicate the flow of 
materials, goods or processes. 
 

 
 
 
[ DISCUSSION ] Adding, re-ordering, deleting items. 
 
If shapes were missed or are added and need to be included, opening the 'Define Value Stream Path' dialog and pressing 
the record button allows you to add any new shapes.  To re-order shapes, there are up and down arrows provided.  To 
delete shapes recorded in error, use the 'X' button in the dialog. 
 

 
 
F: Close the Value Stream Path Dialog 
 
G: Deselect the Value Stream Path shape. Notice that the numbered bubbles only appear when you select the Value 
Stream Path shape. This is in order to signify which path belongs to which value stream path shape. 
 
H: Don’t forget to save your work!!! 
 
With LeanView, you can analyze and report on single or multiple value streams, as well as “sub” value streams. 
 
I: Rename the process steps, from left to right “Receiving & Prep”, “Paint”, and “Assembly”. 
 
(Save your diagram) 
 

  
1

Paint

I I

1

Receiving & Prep

1

Assembly

Arrow buttons can be used to reorder the shape list.  

These buttons will move the selected row/shape up 

or down. 

The ‘x’ button will delete any unwanted shapes/rows 

from the path shape list. 



LeanView™       The Next Generation of Lean          Copyright 2012           bluespring | SOFTWARE                    Page 21  
 

www.bluespringsoftware.com 

Section VI: Producing the Map Analysis Report 
 
 
A:  To create a Map Analysis Report (MAR), navigate to the Analysis section of the LeanView ribbon and click Map 

Analysis Report. 
 

 
 
B:  A prompt to select the value path for analysis and time units to be used for reporting will be presented.   
 

 
 
You will notice that you can change your report time units. LeanView will automatically normalize and recalculate all 
time statistics in the chosen time units when writing the Excel Report. 
 
C:  Accept defaults and Click “OK”.  LeanView will launch Microsoft Excel and begin writing the Map Analysis Report 

(MAR). 
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Section VII: Inventory 
 
There are several ways to account for Inventory or Work In Process (WIP) items in a LeanView value stream map. 
 
1)  Inventory, Warehouse and Queue shapes will contribute to the value path flow time as well as inventory quantities 

and costs reported.  
 

Inventory/Warehouse/Queue: 
 

 
 

WIP inside these shapes, when recorded in the Value Stream Path, affect the flow time of the value stream by using 
a weighted average of the flow time based on the quantity and mix of items stored in the inventory. 

 
 
2)  Information captured in the Pieces tab of the Transport and Process properties dialogs will be incorporated in the 

inventory quantity and costs reported. 
 
 
 

 
 
 
 
 
 
 
 

 
 
 

In the pieces tab, items entered here represent the pieces per process unit being processed or transported.  
(Example: if you’re assembling wagons, you would have 4 tires per wagon, so you would have a “Wheel” item with 
Pieces Per Process Unit of “4”.) 
 
In a process shape, if there is batch processing (Normal Process Quantity > 1), LeanView will multiply the Pieces per 
Unit by the number of concurrent units (Normal Process Quantity*Stations) to determine the quantity of inventory 
associated with that process step.  If the Normal Process Quantity for an activity is 50, the number of stations is 1, 
and the Pieces per Unit is 4, the quantity of inventory added to the total reported is 200 (50 * 4 * 1 = 200).  With 
this, LeanView augments standard Value Stream Mapping techniques to more accurately account for in-process 
inventory materials.  

 
  

Transport

1

Process
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Section VII: Inventory 
 

Refer back to the example built previously with the 3 process steps. 
 

 
 
A: Go to the Map Properties and open the “Raw Material/WIP” tab. 
 

 
 
The Raw Material/WIP tab is used to keep track all of the raw material and WIP used or needed in order to manufacture 
or produce those items in customer demand.  If, for instance, the demand is for 20 bicycles and 2 wheels are needed for 
each bicycle, than the raw material needed is 40 wheels. 
 
B: Enter the Raw Material/WIP items listed below and click “Save”, then “Close” 

 
 
 
 
WIP ITEMS 
 
Item   Quantity Price 
Frames   300   $38.00 
Parts Kit  300   $44.99 
Tires   600   $14.50 
 
 
 

 
C:  Rename each of the inventory shapes so that they can be uniquely identified in the Map Analysis Report.  Right-click 

on each of the inventory shapes and choose “Show Title” or select all inventory shapes at once and click the “Show 
Title” option in the View section of the LeanView ribbon. 

 

     

I I

Inventory
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Section VII: Inventory 
 
D:  Rename the inventory shapes, working from left to right, “Bin 1” and “Bin 2”. 
 

 
 
E:  Select Bin 1 inventory, right-click and choose “Inventory Properties”. 
 

Use the ‘+’ button to add new rows to the inventory shape list on the General Tab.  Click in the Name column to 
reveal a drop-down list of Finished Goods and Material/WIP items from which to choose.  This drop-down list is 
populated with the information defined on the Demand and Material/WIP tabs of the Map Properties shape. 
 

  
 
The inventory properties dialog is where the count of items observed in inventory may be documented.  If you were 
to walk out onto the production line and count items in inventory at a particular point in time, this is the quantity 
that you would enter. Sampling on multiple occasions may be helpful here to arrive at an average inventory count.  
Documenting this inventory allows us to calculate the time and cost associated with the raw materials and WIP in a 
value stream. 

 
F:  For Bin 1, let’s select “Frames” and enter a Quantity of 80.   
 

You will notice that after clicking “Save”, 
your days-supply of each inventory item 
is automatically calculated.  You will 
notice that the inventory shape has the 
option of allowing LeanView to 
automatically calculate Flow Time for 
you or you can manually enter it. Use 
dropdown selector to select the 
appropriate option for you. 

 

1

Paint

I

Bin 1

I

Bin 2

1

Receiving & Prep

1

Assembly
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Section VII: Inventory 
 

Pieces 
 
There may be steps in this Value Stream where we are processing more than one unit at a time (Normal Process 
Quantity > 1), so it would be advantageous for us to account for WIP inside the process steps. 
 
A:  Go to the Paint Process Properties, select Frames in the Pieces tab, and enter a quantity of 1. Notice that the 

dropdown list under Name is also populated from the list in the Material/WIP tab on the Map Properties. 
 

  
 
B:   In Bin 2, enter 100 Parts Kits, 45 Frames and 62 Tires 

C:   In the Warehouse Properties, select “500 Series” and enter a quantity of 150.  

D:   In the Assembly Step Process Properties, enter 1 Frame, 1 Parts Kit and 2 Tires in the Pieces tab 

E:   Produce a Map Analysis Report and review the Inventory worksheet. 

 

 
  

1

Paint
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Section VIII: Parallel Paths 

 
Continuing with the bicycle assembly plant value stream… 
 
A:  Assume there is a sprocket and pedal assembly process that happens in parallel for use in the main value stream 

assembly step.  Add a new process shape to the drawing canvas as shown below and name it ‘Sprocket & Pedal 
Assembly’.   

 

 
 
While parallel processes may not affect the flow time of the critical value stream, they will cause other effects, such 
as people and inventory costs, which need to be included in the analysis data. 

 
B:  Access the process shape properties and enter flow time and manual time of 10 minutes. 

 
 
 
 
 
 
 
 
 

 
C:  Right click the Value Stream Path Shape and choose “Define Value Stream Path”. 
  
D:  Open the Parallel tab.  
 
E:  Click on the Red record button and select the 

sprocket and pedal assembly shape. 
 

  

Value Path
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Section VIII: Parallel Paths 
 

F:  Click the “Save” Button 
 
G:  Click “Close” and save your Value Stream Map 
 
H:  Generate a new Map Analysis Report and review the differences in computed values with Parallel activity added. 
 

 
 
 
 
 
 
 
 
 
 
 

Section IX: AutoDraw and AutoRecord 
 

Using AutoDraw 
 
A:  Create a new LeanView diagram using the 

LeanView Template. 
 
 
 

  

Parallel Path shapes do not contribute to the Flow Time, 

but the work is incorporated in the path total reported for 

Manual Time, Auto Time, and Work Time. 
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Section IX: AutoDraw and AutoRecord 
 

Using AutoDraw 
 
B:  Right click your mouse on the Map to expose the right-click menu (see image to right).  

You will notice that the right-click menu has several options for shapes you can 
automatically draw on the map. 

 
 This functionality allows for quick drawing of first order representations of Value 

Stream Maps, and enhances the ability to follow along during VSMA events. 
 
C:  Choose the “Map Sequence” option on the right-click menu.  You will see the Map 

Sequence dialog appear.  The Map Sequence Dialog allows you to quickly and easily 
draw an entire Value Stream Map. 

 

 
 
 
D:  Enter 15 for Process Steps, leave all other defaults and click “OK”.  There will be a slight delay while the value stream 

map is drawn for you.  You will notice that it starts with a supplier, includes push arrows and inventories and the 15 
processes we designated. It ends with a warehouse and customer at the end of the Value Stream Map. 
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Section IX: AutoDraw and AutoRecord   
 
E. Insert a new page into the existing Visio file or open a new LeanView diagram.  Right-click on the map and choose 

“Process”. Right-click on the Process and choose “Push to Process”.  Repeat that step for the next process.  Right 
click on the last Process and choose “Push to Warehouse”.  Finally, right click on the warehouse and choose 
“Finished Goods to Customer Sequence”.  Your Map should look like this: 

 

 
 
 
 
Using AutoDraw with AutoRecord 
 
 
A:  Begin this section with an empty LeanView diagram.  
 
B:  Right-click on the Value Path shape and choose “Define Value Stream Path”. 
 
C:  Click the Red Record button on the Items tab. 
 
D:  Keep the Value Path dialog open, right-click on the map, and choose the “Map Sequence” option. 
 

    
 

 
 
  

Value Path
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Section IX: AutoDraw and AutoRecord   
 
E:  In the Map Sequence dialog, choose 3 processes with 

everything else checked, and click OK.   
 

  
 
 
 
 
 
 
LeanView automatically records the Value Stream Path while it draws it for you! 
 

 
 
Other AutoDraw Functionality 
 
Returning to our Performance Series Bike Manufacturing VSM, we have represented the flow of material; let's also 
represent the flow of information. 
 
A: Drag an “Information” rectangle onto the top center of the map from the Information shape stencil.  

 

 
 

  

Supplier

Transport

1

Paint

I

Bin 1

I

Bin 2
Warehouse

Customer

1

Receiving & Prep

1

Assembly

Information
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Section IX: AutoDraw and AutoRecord   
 
B:  Select the Information Shape. 
 
C:  Hold down the “Ctrl” key and use your mouse to select all three process shapes. 
 

 
 
D:  Release your mouse, then right-click on the information shape to expose the right click menu. 
 
E:  Choose the “Electronic Information Flow” option. 
 
 
 
 
 
  

1

Paint

I

Bin 1

I

Bin 2

1

Receiving & Prep

1

Assembly

Information
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Section X: High Level & Detailed Maps & Roll -up Analysis 

 
When we evaluate a Value Stream at the high level, it is sometimes necessary to gain greater understanding by 
evaluating sub processes or sub assembly lines.  In LeanView, you have the ability to create sub maps either in the same 
document, or you can maintain them in separate files.  LeanView allows you to link these sub-maps to their higher level 
processes, so that when you run the analysis, data is “rolled up” to the higher level ‘master’ value stream map.  This roll-
up capability gives LeanView extreme flexibility and power. 
 
Creating and Linking Sub-maps in the same document: 
 
Continuing with the Performance Series CS VSM, we are going to break out the “Paint” step into a sub processes. 

 
 
Though not required, it’s advisable to create your sub-maps on separate pages or to maintain them in separate files to 
facilitate organization.  For this exercise, we will use a pre-crafted sub-value stream map in a separate file.  If you choose 
to create your own sub-value stream map in a new page, use the instructions below to add a new page to an existing 
Visio file. 
 
To add a new page to a Visio file, right-click on the page tab 
and choose ‘Insert’ from the context menu, use the ‘Insert 
Page’ icon, or navigate to the Visio Insert tab and select 
‘Blank Page’. 
     
  
 
To rename a new page, right-click on the page tab and choose ‘Rename’ from the context menu or access the Page 
Setup dialog through the Visio Design tab and go to the Page Properties tab. 
 

 

 

1

Paint
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Section X: High Level & Detailed Maps & Roll -up Analysis 
 

A:  Open the Paint Sub VSM.vsd that has been provided.   
 

 
 

Notice, these shapes have been pre-populated with time, yield, %VA, WIP and Inventory data.  The process data is 
shown below and each of the inventory bins contain 1 Frame. 

 

 Paint Prep Prime Paint Deprocess Inspect 

People Total 1 1 1 1 1 

Stations 1 6 4 1 1 

FT 7 Mins 45 Mins 25 Mins 5 Mins 2 Mins 

MT 7 Mins 8 Mins 8 Mins 5 Mins 2 Mins 

AT 0 0 0 0 0 

% Yield 100% 100% 98% 100% 95% 

% VA 0% 0% 100% 0% 0% 

Pieces 1 Frame 1 Frame 1 Frame 1 Frame 1 Frame 

 
B:  Now go back to the high level map and open the “Paint” process properties dialog.  Check the “Use SubPath” box.  

You will receive a prompt to confirm the intent to link to a sub path.  Click “Yes”. 
 

 

1

Paint Prep

1

Prime

I

Bin 1

1

Paint

I

Bin 2

1

Deprocess

I

Bin 3

1

Inspect

I

Bin 4
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Section X: High Level & Detailed Maps & Roll -up Analysis   
 
C. Browse to the location of the ‘Paint Sub VSM.vsd’ and choose the Path Shape ‘Paint Sub VSM’. 
 

 
 
Note, if the sub-value stream path is in the same Visio file as the master path, the ‘Use Relative Path’ option can be 
used. 

 
D:  After clicking “OK”, you will be back at the Process properties dialog. You will need to click “Save” to complete the 

linking process. 
 

 
 
 You will now notice a blue circle with an arrow in the lower right corner of the Paint process indicating that you have 

successfully linked to a sub-map. 
 

 
 
E:  Save your Value Stream Map!!! 
 
 

4

Paint

…\Paint Sub VSM.vsd 
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Section X: High Level & Detailed Maps & Roll -up Analysis   
 
Roll-up Analysis 
 
A:  Go to the Analysis section of the LeanView ribbon and choose 

Map Analysis Report.  If working in versions 4 or 5 of LeanView, 
go to the LeanView menu, choose Reports, and select the Map 
Analysis Report. 

 
 

B:  Choose the master Value Path Shape dropdown box, and uncheck “Report Master Path Only”.  Note that the 
“Report Master Path Only” box is only enabled if you’ve chosen a Value Path that has sub-paths attached to it.  It is 
disabled otherwise. 

 

 
 
C:  Click “OK” to begin the Roll-up Analysis. 
 
D: In the Map Analysis Report worksheets, sub-path data can be exposed or hidden by clicking the ‘+/-‘ sign next to the 

summary process shape name. 
 

  

Sub-Path data is accessed 

by clicking the ‘+’ sign next 

to the Paint activity. 
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Section XI: Advanced Analytics 
 
In evaluating a Value Stream for potential improvements, it is important to understand the analytics that LeanView 
provides, in order to make more informed decisions.  To obtain information about value stream performance and 
potential for improvement, the LeanView Map Analysis Report (MAR) should be used. 
 
Map Analysis Report (MAR)  

The MAR workbook is composed of ten worksheets: Value Added Timeline, Value Stream, Takt Analysis, Sorted Metrics, 

Inventory, Delays, Process Waste, VSM Data, User Data and Path Notes.  

Note that the Performance Series CS VSM example does not incorporate user properties, waste data, delays or path 

notes.  Therefore, these worksheets would be omitted from the MAR received in the previous section.  They are 

described in this section for informational purposes. 

 Value Added Timeline – this worksheet shows the total flow time and highlights when the value added time 

occurs using green on the horizontal bar.  Additionally there is a pie graph showing the percent of value added 

versus non-value added time. The summary table shows each process/ inventory/ transfer and its individual 

VA/NVA flow time. 

 

 

  

   

- 10.00 hrs 20.00 hrs 30.00 hrs 40.00 hrs

A
ct

iv
it

y

Value Added Timeline

VA
15%

NVA
85%

Value Added 
Summary

VA NVA

Activity Name VA NVA

Supplier - -

Transport - -

Receiving & Prep - 0.30 hrs

Bin 1 - 10.67 hrs

Paint 0.13 hrs 1.63 hrs

Bin 2 - 7.82 hrs

Assembly 7.11 hrs 0.14 hrs

Warehouse - 20.00 hrs

Customer - -

SubTotal 7.24 hrs 40.57 hrs

Total 47.81 hrs
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Section XI: Advanced Analytics 
 

Map Analysis Report (MAR)  

 Value Stream – the value stream worksheet provides the overall performance for the value path as well as the 

performance metrics for shapes that make up the path.  

 

 
 

 Takt Analysis – this sheet is used to compare process flow times to takt time 

 

  

 

 

 

 

 

 

 

 

 

  

Value Stream:  Value Path

Activity Name Type

Flow 

Time 

(FT)

Manual 

Time 

(MT)

People 

(FTE)

Total

Work

Auto 

Time 

(AT)

Transfer

Time

% Yield 

(YLD)

Value

Added

Time

NVA

Time

Value 

Stream

Yield

Cumulative

Flow Time

Supplier Supplier - - 100% -

Transport Transport - - 100% - 100% -

Receiving & Prep Process 0.30 hrs 0.15 hrs 1.00 0.15 hrs - 95.0% - 0.30 hrs 95.0% 0.30 hrs

Bin 1 Inventory 10.67 hrs 10.67 hrs 95.0% 10.97 hrs

Paint Summary 1.77 hrs 0.47 hrs 4.00 0.47 hrs - 100% 0.13 hrs 1.63 hrs 95.0% 12.74 hrs

Paint Prep Process 0.12 hrs 0.12 hrs 1.00 0.12 hrs - 100% - 0.12 hrs 95.0% 11.09 hrs

Bin 1 Inventory 0.13 hrs 0.13 hrs 95.0% 11.22 hrs

Prime Process 0.75 hrs 0.13 hrs 1.00 0.13 hrs - 100% - 0.75 hrs 95.0% 11.97 hrs

Bin 2 Inventory 0.13 hrs 0.13 hrs 95.0% 12.10 hrs

Paint Process 0.42 hrs 0.13 hrs 1.00 0.13 hrs - 100% 0.13 hrs 0.28 hrs 95.0% 12.52 hrs

Bin 3 Inventory 0.13 hrs 0.13 hrs 95.0% 12.65 hrs

Deprocess Process 0.08 hrs 0.08 hrs 1.00 0.08 hrs - 100% - 0.08 hrs 95.0% 12.74 hrs

Bin 2 Inventory 7.82 hrs 7.82 hrs 95.0% 20.56 hrs

Assembly Process 7.25 hrs 7.00 hrs 1.00 7.00 hrs 0.11 hrs 97.0% 7.11 hrs 0.14 hrs 92.2% 27.81 hrs

Warehouse Warehouse 20.00 hrs 20.00 hrs 92.2% 47.81 hrs

Customer Customer - - 92.2% 47.81 hrs

Sprocket & Pedal
Assembly Process 0.17 hrs 1.00 0.17 hrs - 100% -

Path Total 47.81 hrs 7.78 hrs 7.00 7.78 hrs 0.11 hrs - 7.24 hrs 40.57 hrs 92.2% 47.81 hrs

Takt Time 8.00 mins Percent Value Added Time 15.15%

The Flow Time shows 

the total time it takes 

an item to get 

through each step 

from start to finish.  

Cumulative Flow 

Time shows the 

total time it 

takes an item to 

traverse from 

the path start 

through any 

given point on 

the path.  

Total Work is 

determined by 

multiplying the 

Manual Time and 

People (FTE).  

For a Process shape, 

Value Added Time is 

processing time (MT + 

AT) multiplied by %VA. 

NVA Time = 

Flow Time – VA Time 

-

0.02 hrs

0.04 hrs

0.06 hrs

0.08 hrs

0.10 hrs

0.12 hrs

0.14 hrs

Receiving & Prep Paint Assembly Packing

Time Per Unit Vs. TAKT

If the Time Per Unit is greater than the Takt Time, this 

indicates the process is incapable of meeting the pace of 

demand.  Either the takt time must be increased (less 

demand and/or more available work time), the flow time 

must be decreased (reduce processing time and/or eliminate 

delays), or the concurrent units must be increased (add 

stations and/or increase the normal production quantity). 

TAKT Analysis:  Value Path

Step Flow Time Takt Time Takt Ratio Concurrent Units Time Per Unit

Receiving & Prep 0.30 hrs 0.13 hrs 2.25 1.00 0.30 hrs

Paint 1.77 hrs 0.13 hrs 13.25 1.00 1.77 hrs

Assembly 7.25 hrs 0.13 hrs 54.38 1.00 7.25 hrs

Total 9.32 hrs 0.40 hrs 23.29 1.00 9.32 hrs

Takt Ratio = Flow Time / Takt Time 

Concurrent Units are determined 

by multiplying the Normal 

Production Quantity and Stations. 

Time Per Unit = Flow Time / Concurrent Units 
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Section XI: Advanced Analytics 

Map Analysis Report (MAR)  

 Sorted Metrics – this sheet may be used to establish a priority sequence for process improvements; activities are 

listed in order of contribution to each of six performance metrics:  NVA Time, Flow Time, Manual Time, Auto 

Time, Change Over Time, and Yield. 

 

 

 

 

 

 

 

 

 

 

 Inventory – this sheet is used to assess the total amount of inventory tied up in the value stream and the 

opportunity to reduce this investment. The total quantity in inventory is summed for each item type and the 

associated cost is reported.  Note the unit cost and consumption rates for inventory items are defined in the 

value stream map properties.  Unit cost and consumption rates from sub-paths may differ from the high-level 

summary (parent) value stream; consumption rates and unit costs within sub-paths are adjusted for any 

differences in the value stream map properties.  The inventory turns in the customer demand period are then 

calculated based on these consumption rates and inventory quantities.  

 

 
 

 

  

Process Sorted Metrics:  Value Path

Process

NVA

Time Process

Flow 

Time 

(FT) Process

Manual 

Time 

(MT) Process

Auto 

Time 

(AT) Process

Change 

Over 

Time 

(CO) Process

% Yield 

(YLD)

Prime 0.75 hrs Assembly 7.25 hrs Assembly 7.00 hrs Assembly 0.11 hrs Receiving & Prep - Receiving & Prep 95.00%

Receiving & Prep 0.30 hrs Prime 0.75 hrs Sprocket & Pedal
Assembly 0.17 hrs Receiving & Prep - Paint Prep - Assembly 97.00%

Paint 0.28 hrs Paint 0.42 hrs Receiving & Prep 0.15 hrs Paint Prep - Prime - Paint Prep 100%

Assembly 0.14 hrs Receiving & Prep 0.30 hrs Prime 0.13 hrs Prime - Paint - Prime 100%

Paint Prep 0.12 hrs Sprocket & Pedal
Assembly 0.17 hrs Paint 0.13 hrs Paint - Deprocess - Paint 100%

Deprocess 0.08 hrs Paint Prep 0.12 hrs Paint Prep 0.12 hrs Deprocess - Assembly - Deprocess 100%

Sprocket & Pedal
Assembly - Deprocess 0.08 hrs Deprocess 0.08 hrs Sprocket & Pedal
Assembly - Sprocket & Pedal
Assembly - Sprocket & Pedal
Assembly 100%

NVA

Time

Flow 

Time (FT)

Manual 

Time 

(MT)

Auto 

Time 

(AT)

Change 

Over 

Time 

(CO)

% Yield 

(YLD)

Inventory Quantities come from 

inventory shapes recorded into 

the value stream path. 

Average Unit Cost and Consumption 

in Period are defined in the Value 

Stream Map Properties 

Turns in Period = 

Consumption in 

Period / Total 

Inventory 

Quantity. This is a 

typical measure of 

inventory 

performance. If 

inventory on hand 

is reduced, 

inventory turns 

will increase. 

Value = Inventory Quantity * Average Unit Cost 
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Section XI: Advanced Analytics 

Map Analysis Report (MAR)  

 Delays – this worksheet is used to assess the total delay time documented in the Value Stream.  Each delay type 

is summarized for the value stream and total delay time by activity is also shown.  The contribution of each type 

of delay to the total delay time is reported and a comparison between the delay time and flow time is 

calculated. 

 

 
 

 Process Waste – this worksheet summarizes the annual cost associated with the 7 major lean wastes 

 

 

Delays:  Top Level CS VSM

Activity Name Activity Type Rework Scrap Total

Transport Transport -

Receiving & Prep Process - 0.01 hrs 0.01 hrs

Paint Process - - -

Assembly Process 0.15 hrs - 0.15 hrs

Packing Process 0.00 hrs 0.08 hrs 0.09 hrs

Transport Transport -

Total Delay Time 0.15 hrs 0.09 hrs 0.24 hrs

Percent (%) of Delay 62% 38% 100%

Total Flow Time 34.84 hrs 34.84 hrs 34.84 hrs

Percent (%) of Flow Time 0% 0% 1%

Delays are defined in the 

properties dialog of LeanView 

process and transport shapes. 

Waste is defined in the 

properties dialog of LeanView 

process shapes. 
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Section XI: Advanced Analytics 

Map Analysis Report (MAR)  

 VSM Data – this sheet lists the key data values entered for the shapes in the value path and is intended as a 

quick reference for input data values as an alternative to checking the data in the shapes of the VSM.  Where 

appropriate, the values are totaled.   Information is summarized for the value stream map properties, process 

shapes, inventory shapes, transfer shapes, transportation shapes and queue shapes.  

 

 

  

Summary Data:  Top Level CS VSM

Demand Period 40.00 hrs

Takt Time 8.00 mins

Work Time

Hours Per Day 8.00 hrs

Days Per Week 5.00 days

Days Per Year 250.00 days

General Properties

Map Type Manufacturing

Map State Current

Customer Name We R Bikes

Product Family

Performance 

Series Bicycles

Author

Erica 

Wittenmyer

Produced For

Training & 

Demonstration

Master Item List

Top-Level Map (Bike Manufacturing VSM.vsd)

Product

Base

Demand Units Price

Demand

Factor

Projected

Demand

500 Series 300 Units $224.00 1 300

Raw Material/WIP

Base

Demand Units Price

Demand

Factor

Projected

Demand

Frames 300 Units $38.00 1 300

Parts Kit 300 Units $44.99 1 300

Tires 600 Units $14.50 1 600

Process Step Flow Time (FT)

Manual Time 

(MT)

Auto Time 

(AT) People (FTE)

Normal 

Process 

Quantity

Change Over 

Time (CO)

% Yield 

(YLD)

Percent

Value Added Stations

Normal 

Production 

Run

Receiving & Prep 18.00 mins 9.00 mins 4.00 mins 3 1 - 95.0% 0.00% 3 1

Paint 1.93 hrs 0.50 hrs - 5 1 0.25 hrs 95.0% 26.67% 6 1

Assembly 435.00 mins 7.00 hrs 6.50 mins 55 1 - 97.0% 20.00% 55 100

Packing 13.75 mins 13.00 mins 45.00 secs 2 1 - 98.0% 10.00% 2 1

Order Confirmation 30.00 mins 3.00 mins - 1 1 - 100% 100.00% 1 1

Invoicing / Accounting 30.00 mins 6.00 mins - 1 1 - 100% 0.00% 1 1

Process Total 10.71 hrs 8.02 hrs 0.19 hrs 67.00 0.25 hrs

Inventory Qty Units Supply

Bin 1

Frames 80 Units 1.3333 days

Bin 2

Parts Kit 100 Units 13.3333 hrs

Frames 45 Units 6 hrs

Tires 62 Units 4.1333 hrs

Bin 3

500 Series 40 Units 5.3333 hrs

Warehouse Qty Units Supply

Warehouse

500 Series 10 Units 1.3333 hrs

Total:500 Series 50 Units 1 Days

Total:Frames 125 Units 2 Days

Total:Parts Kit 100 Units 2 Days

Total:Tires 62 Units 1 Days

Transfers

Transfer

Time

Push 0.2 hrs

Transfers Total 0.20 Hrs

Transportation

Transport

Time

Shipping

Interval

Transport 4 hrs 40 hrs

Transport - -

Transportation Total/AvgWait 4.00 Hrs 20.00 Hrs

Value Stream Map Properties 

Summary 

Finished Goods and 

Material/WIP Summary 

Process Properties Summary 

Inventory and Warehouse 

Properties Summary 

Transport and Transfer 

Properties Summary 
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Section XI: Advanced Analytics 

Map Analysis Report (MAR)  

 User Data – if custom user properties have been defined in the Visio shape data window for LeanView shapes 

recorded into the value path, these properties will be reported in the user data worksheet of the MAR.  Both 

textual and numeric shape data can be defined and incorporated in the MAR.  Numeric properties are summed 

and averaged and the minimum and maximum values are identified.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Path Notes – all data captured in the notes tab of the properties dialog for LeanView shapes recorded into the 

value path will be reported in the path notes worksheet of the MAR.  

 

Section XII: JDIs / Projects / Events 

 
LeanView gives users the ability to identify opportunities for improvement, often called “Action Items” directly on the 
Value Stream Maps in the form of JDIs (Just Do Its), Projects or Events.  The procedures for creating each one of these 
are identical; the shapes, however, are different colors to differentiate between them on the map. 

 

 
 
All three are shaped as bursts, and are available on the General shape stencil in LeanView. Just Do Its are labeled simply 
“Do It” and are light blue in color.  Project shapes are dark green in color and Events are Yellow. 
 
Typically, a ‘Do It’ or ‘JDI’ (Just Do It) shape denotes obvious process improvement actions that should be implemented 
without additional approval or decision making.  An ‘Event’ is slightly more involved than a ‘Do It’ and identifies 
additional kaizen events or process improvement events that must be scheduled.  A ‘Project’ shape is used to capture 
information about improvement projects and a list of the essential tasks associated with each; a Project is slightly more 
involved than an Event and will require resource allocation, planning and costing. 

User Defined Data:  Top Level CS VSM
Top Level CS VSM

Activity Name Distance Traveled

Supplier

Transport

Receiving & Prep 75

Bin 1

Paint 125

Bin 2

Assembly 35

Bin 3

Packing 65

Push

Warehouse

Transport

Customer

Order Confirmation

Invoicing / Accounting

Total 300

Average 75

Minimum 35

Maximum 125

User Defined Data:  Top Level CS VSM
Top Level CS VSM

Activity Name Distance Traveled

Supplier

Transport

Receiving & Prep 75

Bin 1

Paint 125

Bin 2

Assembly 35

Bin 3

Packing 65

Push

Warehouse

Transport

Customer

Order Confirmation

Invoicing / Accounting

Total 300

Average 75

Minimum 35

Maximum 125

2

YLD 98.00%

CO 0.00 Hrs

AT 45.00 Secs

MT 13.00 Mins

FT 13.75 Mins

Packing

Custom properties captured in the Visio 

shape data window are reported in the 

User Data worksheet of the MAR. 
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Section XII: JDIs / Projects / Events  
 
These ‘burst’ shapes are preconfigured to capture a description of the proposed event or action, the reason for the 

action, as well as information about the owner, team members, and tasks to complete the proposed event. 

 

 

Team Tab 

These input fields are used to identify the project 
owner and team members. 
 
Event Tab 
These fields are used to capture the purpose of the 
proposed actions and a brief description of the 
improvement tasks to be performed.  
 
Goals Tab 
These fields store information about tasks to be 
completed to improve value stream 
performance. 
 
Rating Tab 
This tab allows you to rate an Event/Project 
according to its Potential for Improvement 
and Degree of Difficulty.  

 

 

 

 
  

Implement Challenge

Possible Kill

Degree of DifficultyP
o

te
n

ti
al

 f
o

r 
Im

p
ro

ve
m

en
t Rating 
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Section XII: JDIs / Projects / Events  
 
A:  To create a JDI/Project or Event on your LeanView Map, simply drag one of the shapes onto your Value Stream Map, 

and position it where you need the improvement.  Continuing to work with the Performance Series CS VSM, drag a 
Project shape onto the page. 

 

 
 
B:  Double-click on the Project shape and rename it “Improve Core Yield”. When finished typing, click outside the shape 

to save the change.  
 

       
 
C:  Once an action item is on the map, you can right-click on the shape to access its properties. 
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Section XII: JDIs / Projects / Events  
 
D:  As previously described, the burst properties dialog has 4 tabs: Team, Event, Goals and Rating. 
 

    
 
 
E:  On the Team tab, identify the Project Owner as Jane and add Team Members John, Mike and Mary. 
 

 
 

F:  Enter the Event Description and Reason for Event as described below. 
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Section XII: JDIs / Projects / Events  
 
G:  Navigate to the Goals tab and enter a goal of “Evaluate Methods to Improve Core Yield”.  Define a start date of the 

current date and an end date 15 days later, enter Resources of “Mike, John, Mary”, and add a Fixed Cost value of 
$4500.”  This data can be used to build project plans in either Microsoft Excel or Project, if you desire, to give you 
visibility into execution of action items. 

 

 
 

H:  The final tab is the action item rating.  This allows you to rate the action item with respect to its degree of difficulty 
and its potential for improvement.  Select the “Challenge” square. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
I: Now, click “Save”. 
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Section XII: Out Briefing to Microsoft PowerPoint  
 
A:  Make sure the Performance Series CS VSM Map Analysis Report is open in Excel, return to Visio, and go to the 

Analysis section of the LeanView ribbon and choose PowerPoint Outbrief → JDI/Project/Event Actions.  (If working in 
LeanView versions 4 or 5, go to the LeanView menu and choose Reports  PowerPoint  JDI/Project/Event 
Actions.) 

 

 
 
B:  Select the Value Path to be analyzed and use <Open From File> for the File Name.  This will allow you to select the 

template to be used to compose the PowerPoint slide deck. 
 

 
 
C:  LeanView supplies several PowerPoint templates for reporting.  These templates are stored inside the LeanView 

Templates folder with the installation.  Navigate to C:\Program Files\Bluespring\LeanView\Templates and select the 
“Lean Event Action Items.pot” and click “Open”.  LeanView will then open a new Microsoft PowerPoint presentation 
and begin drafting the report slides. 

 

 
 
 
  

Note: If you have developed a custom report template and do not see it in the list of available 

templates when you browse to the storage location, change the file type to ‘All Files’. 
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Section XII: Out Briefing to Microsoft PowerPoint   
 
D:  Before LeanView builds the report, a prompt to identify the file storage location will be presented.  Once you are 

satisfied with the directory name and location defined to store the report, Click “Save”. 
 

 
 
 

When the report is finished you will get the following dialog: 
 

 
 
 
 

A slide like the one shown will be created for 

each action item or improvement 

opportunity shape on the LeanView diagram. 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  LeanView provides a number of additional reports to Microsoft Excel, PowerPoint, Project and Word not 

discussed in this exercise.  For more information, review the Users’ Guide in the LeanView Help menu. 


